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What’s New in WinCross Version 16 

We are excited about the many enhancements in WinCross 16. Our Express features, from running simple tables, to 
creating tables and banners from your data file, will now work with all variable-type data. We are confident that the 
enhancements to our variable data grid will allow you to handle all of your variable and data changes within WinCross. 

  

New Feature Highlights for Version 16:  

 Our new TAG Drive cloud-based file storage lets you open and save your job, data and report files for access 
from anywhere. 

 Change Excel display options without having to rerun tables using our new Excel filtering column.  

 Reduce setup time for banners with the new copy and paste functionality for banner columns. 

 Let our new Regression module answer your multiple regression analysis needs.  

 Significance results are now at your fingertips with the addition of significance testing to our quick-and-easy 
ExpressTabs. 

 Now that WinCross express features are no longer limited to just SPSS data, processing ExpressTabs and 
creating banners and tables is easier than ever. 

 Create express frequency and statistical reports, split data into new variables, merge multiple variables into a 
single new variable, generate random values, fill missing values with means and spell-check selected cells from  
a simple right-click on the data grid for all variable-type data. 

 You can easily change the order of variables in your data file with the addition of the Sort Ascending by Variable 
Name and Sort Descending by Variable Name options to the right-click context menu of the data grid. 

 Save time and energy when you need to add records or variables to your data file now that you can specify 
variable type and format and copy records and variables from the Windows clipboard. 

 Data decimal precision can be changed in a flash with the addition of Round Selected Data to ‘n’ Places on the 
data grid right-click context menu.  

 Eliminate unnecessary steps for cleaning or merging data now that data saved by the Glossary, Simple 
Weighting, Sample Balancing and Factor Analysis retains the original field width for all variables. 

 Create your own data file in WinCross with the addition of New Data File to the File Menu options.  

 It is no longer necessary to leave that job and/or file open with the new Close Job and Close Data File options 
added to the File Menu. 

 The new Quick Tools options provide a quick-and-easy way to calculate significance, statistics, frequencies and 
sample sizes. 

 Increased memory capacity for 64-bit operating systems and new maximums for record length and number of 
variables provides greater WinCross processing capability. 

 The new square root function of the CALC statement offers more row and column logic definitions. 

 Added flexibility using the SUB command with the addition of ENDSUB. 

 DECLARE new variables in the Glossary without the need to assign record/column locations or use ADDLEN. 

 The Glossary ASSIGN instruction can now be implied for some syntaxes making it easier to use. 

 Enhanced Text Reports can now be personalized with multiple logos and additional logo placement options. 

 Exporting to Excel has been simplified with the addition of Excel to the options for Report viewing formats and 
the automatic launch of Microsoft Excel. 

 Excel Report Options are now presented in a tab view with options organized by type.  

 Excel Formatting Options offer even more flexibility for Table of Contents creation and worksheet names while 
creating a Table of Contents becomes the new WinCross default. 

 WinCross now provides more control over banner column width for Excel Reports by respecting the column 
width specifications from the Setup Banners dialog for Enhanced Text Reports. 
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 Use the new Show job file definition view check box to display the Job file definition window or leave it 
disabled to display more tables on the Express Tables from Variable Data dialog. 

 Express Tables from Variable Data now has its own time-saving Filter option allowing you to modify and auto-
increment filter logic on multiple tables at once. 

 New Filter, Reverse scale, Use variable label from first selected variable as table title and Net Using Code 
Values options of Express Tables from Variable Data provide even more time-saving table creation. 

 You can easily double-check your Row Text for spelling errors in the Express Table Editor with the addition of 
the new Word wrap option and implicit spell checking.  

 Save even more time creating USE tables in the Express Table Editor with the new Also apply the table 
options to the selected tables option on the Apply to Other Tables tab. 

 Get true nets when using indexed variables with the new IDXNET/ENDNET, IDX n and IDX-n instructions for 
rows and the new Filter type of Net Total (Indexed) for table filters. 

 Rows can now be grouped together under a programmed net when ranking is assigned providing greater row 
placement control. 

 NET, IDXNET and SUB rows can now be included in threshold determination. 

 You can now show the often-requested Mean number of mentions for both rows and tables. 

 Additional frequency report options for Statistical and Chart representation provide another level of information 
at your fingertips.  

 More statistical information is now available for your frequency reports with the addition of the 1
st

 Quartile, 3
rd

 
Quartile and Values to exclude from Statistics options. 

 Create quick reports by double-clicking either a single table using Run|Tables or a single variable using 
Run|Frequency. 

 Added flexibility for running tables with the new Ignore ranking option. 

 New Sample Balancing options offer an alternative technique for avoiding negative weights and allow you to 
specify the Goodness of fit and Maximum passes for the preferred Goodness-of-fit technique. 

 A new Component score coefficient matrix option has been added to the Report Properties set of reporting 
options allowing for an additional level of Factor Analysis reporting. 

 Factor Analysis now lets you create secondary factor groups for those cases where the highest factor score and 
the second highest factor score are similar. 

 Provide your client with new colorful Enhanced Text Reports that can now be saved in XML, PDF and 
PowerPoint formats for Sample Balancing and Factor Analysis. 

 Creating new variables in your data file for use in running Frequencies, Simple Weighting, Sample Balancing 
and Factor Analysis is a thing of the past now that you can use variables defined or declared in the Glossary. 

 Save time and energy trying to remember that variable name for writing Glossary statements by using the new 
View Data File Information option without having to exit the Setup Glossary Variables dialog.  

 Save your variable-type data files to other formats including ASCII, SPSS, Excel and Comma- and Tab-delimited, 
eliminating the need to go outside of WinCross. 

 The next time your client asks for a median on a banner column, you can easily satisfy their request with the new 
Median banner column option and median rows will become median columns when creating banners from tables. 

 You can now preview that new banner in an Enhanced Text Report format before running tables to make sure it 
is acceptable to you and your client. 

 No need to be embarrassed by a misspelled word in your table titles, filter titles, subtitles, footnotes, etc. now that 
many dialogs in the WinCross interface alert you to possible misspellings. 

 Provide another level of detail for your client with the new maximum of 1000 characters for table titles, subtitles 
and footnotes. 

 New symbols for incrementing/including and excluding logic provide greater flexibility when using VAR+/LOC+ 
banners and tables and row-level statistics and volumes.  
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 Glossary statements can now be entered without regard to case, eliminating unnecessary syntax errors. 

 New status indicators for Table, Frequency, Sample Balancing and Factor Analysis reports eliminate the 
guesswork of whether reports are weighted and have Glossary transformations applied.    

 Compatibility with the latest version of SPSS. 
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TAG Client Portal/TAG Drive 

The TAG Client Portal is our new web-based portal providing a pathway for sharing data using a web browser or mobile 
device. 

TAG Drive is a cloud-based file storage feature of the TAG Client Portal—available to new customers and customers in 
our annual maintenance program—that allows you to open and save job, data and report files in WinCross that are 
accessible from anywhere. 

 

Having access from anywhere can be especially helpful if you are traveling or working from home and do not have access 
to your network drives from outside of the office. 

 

When you click on the TAG Drive tab in WinCross for the very first time, the Welcome to TAG Drive dialog gives you the 
opportunity to Sign Up for TAG Drive.  
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You can add new groups and projects using the Add New Project option from the Projects menu on any TAG Drive tab 
within WinCross or from the Web using the TAG Client Portal.  

 

When you enter a Project group that does not already exist, a new group is added along with the Project name within 
the new group. 

Once a project has been created, you can add files to that project using the Add Files to Project option from the 
Projects or Files menu on any TAG Drive tab within WinCross or you can upload files to your project from the Web using 
the TAG Client Portal. 

See the WinCross online Help topics “Open Data”, “Open Job”, “Open Report”, “Save Data As”, “Save Job As”, “Save 
Report As”, “TAG Drive” and “Add New Project” for more detailed information about opening files from and saving files to 
our new TAG Drive. 



The Analytical Group, Inc.                                                                                                                         WinCross 16 What’s New      10 

New Generate Filtering Column Option for Excel 

Excel Options has a new Generate filtering column option that allows you to filter the rows for display on your Excel 
report. You can change what will display without having to rerun your tables. 
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A hidden column is added to the Excel report that can be used to filter the rows for display. 

 

 
See the WinCross online Help topic “Generate filtering column (Excel Options)” for more detailed information about this 
new feature. 
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Copy and Paste Banner Columns from Clipboard 

The Edit menu of Setup|Banners|Edit Banner has three new options for copying and pasting selected banner columns 
(including logic and options) into a new banner, another existing banner or to a new location in the same banner. 

 

See the WinCross online Help topic “Edit Menu (Edit Banner)” for more detailed information about these new Edit menu 
options. 

 

Regression Module 

WinCross has added a Regression module as an answer to your multiple regression analysis needs.  

 

You can access the Regression module by selecting either Run|Regression or Tools|Regression. 

WinCross' Regression starts by selecting the independent variable that is most correlated with y as its initial independent 
dependent variable. It then uses the adjusted-R

2
 as its metric and, at each step of the process, selects the independent 

variable that, when added to those already selected, produces the largest adjusted-R
2
. It halts when an independent 

variable is selected whose coefficient is not significantly different from 0 using the appropriate t statistic. 

See the WinCross online Help topics “About Regression”, “Regression: ASCII data”, or “Regression: Variable data” or 
Help|Statistical Reference for more detailed information about the new Regression module. 
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Significance Testing Added to ExpressTabs 

ExpressTabs now performs significance testing on your express-table results and allows you to create your own 
comparison groups. 

 

ExpressTabs performs significance testing for percents when Statistics|Show Vertical Percent is selected and 
performs significance testing for means when Statistics|Show Mean is selected. The Dependent Paired/Overlap (Multi) 
test is always used, however, if the data are independent the results would be the same as if the Independent (using 
unpooled proportions) Z-Test was used for percents and the Independent (assume unequal variances) T-Test was 
used for means. 
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By default, significance testing is done for all banner columns. You can use Define Comparison Groups to create 
alternative comparison groups to the WinCross default. 

See the WinCross online Help topics “Run|ExpressTabs” or “Comparison Groups (ExpressTabs)” for more detailed 
information about these new ExpressTabs options. 
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ExpressTabs, Express Tables from Variable Data and Banner Templates from Variable Data 

Processing ExpressTabs and adding tables and banners from your data file has been expanded to other variable-type 
data files. Express Tables from SPSS Data and Banner Templates from SPSS Data from the Setup menu have been 
renamed to Express Tables from Variable Data and BannerTemplates from Variable Data. 

Variable data types include SPSS (*.sav), Comma-delimited (*.csv), Tab-delimited (*.tab or *.tsv) and Excel (*.xls, *.xlsx, 
or *.xlsm). 

 

Non-labeled variable data will use the code values in the data as value labels. 

See the WinCross online Help topics “Run|ExpressTabs”, “Express Tables from Variable Data” or “Banner Templates 
from Variable Data” for more detailed information about using these features. 
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Right-click Context Menu Data Tab Options 

The right-click context menu of the Data tab has new options for creating an Express Frequency Report, Express 
Statistical Report or both Express Frequency and Statistical Reports. You can also Generate Random Values, Fill 
Missing Values with Means, Split Data into New Variables or Merge Data into a New Variable. 

 

These time-saving options allow data changes without leaving the WinCross interface. 

See the WinCross online Help topics “Generate Random Values”, “Fill Missing Values with Means”, “Split Data into New 
Variables”, “Merge Data into a New Variable” or “Create an “Express” frequency and/or statistical report for selected 
variables” for more detailed information about these new options. 
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Spell-checking for the Data Grid 

The Data and Variables tabs of the data grid have a new Spell check option. When enabled, this new Spell check 
option will remain set for each WinCross session. 

 

See the WinCross online Help topic “Editing variable data” for more detailed information about this new data grid option. 

 

Reorder Variables 

The order of variables can easily be changed using the new Sort Ascending by Variable Name and Sort Descending 
by Variable Name options from the right-click context menu on the Variables tab of the data grid.  

 

See the WinCross online Help topic “Sort variables by variable name (Data grid)” for more detailed information about 
these new right-click options. 

Specify Variable Type and Format for New Variables 

The right-click context menu option of Add Variables has been enhanced to let you specify the format Type (Number or 
String) and the Format including the type of Format, Width and Decimals for variables of Number type and Width only 
for variables of String type.  
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Get Variable Count from Clipboard will add the number of variables based on the number of columns currently on the 
Windows Clipboard. 

See the WinCross online Help topic “Add, insert and delete variables (Data grid)” for more detailed information about 
these additional options for adding new variables. 

 
Round Selected Data to ‘n’ Places 

You can easily change data decimal precision using the new right-click Round Selected Data to ‘n’ Places option on the 
Data tab of the data grid.  

 

 Highlight the selection of variable(s) or data values. 
 Right-click anywhere on the Data tab. 
 Choose Round Selection to 'n' Places from the right-click context menu. 
 Enter the number of decimal places (0-16) for rounding. 

See the WinCross online Help topic “Round Selection to ‘n’ Places” for more detailed information about this new option. 
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Saving Data File from Glossary, Simple Weighting, Sample Balancing and Factor Analysis 

Data files saved from Setup|Glossary Variables|Save Data As, Run|Simple Weighting, Run|Sample Balancing and 
Run|Factor Analysis will now retain the width for all variables. Previously, variables greater than 12 characters in width 
were written out with only the first 12 characters of the data. 

See the WinCross online Help topics “Glossary Variables”, “Simple Weighting: Variable data”, “Sample Balancing: 
Variable data” and “Factor Analysis: Variable data” for more detailed information about saving data. 

 

Create a New Data File 

The File menu of WinCross 16 has a New Data File option that allows you to create a new variable data file. 

 

You are prompted to enter: 

 The number of variables. Selecting Get Variable Count from Clipboard, will add the number of variables to the 
new data file based on the number of columns currently on the Windows Clipboard. 

 The type for each variable. Choose either Number or String. 
 For type String, the width of each variable. 
 For type Number, the Format, Width and Decimal places. 
 The number of records. Selecting Get Record Count from Clipboard, will add the number of records to the new 

data file based on the number of rows (records) currently on the Windows Clipboard. 

See the WinCross online Help topic “New Data File” for more detailed information about this new File menu option. 
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Close Job and Data Files 

The File menu has new Close Job and Close Data File options that let you close files without having to open or create a 
new file. 

 

See the WinCross online Help topics “Close Job” and “Close Data File” for more detailed information about these new 
File menu options. 
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Quick Tools 

The Tools menu of WinCross 16 offers a group of convenient tools ranging from a simple calculator to significance testing 
for percentages and means. 

 

Selecting any of the 3 options opens the WinCross Quick Tools dialog to the appropriate tab for that option. 
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The Statistics and Frequency tab lets you enter or copy/paste data values for determining statistics such as Sum, 
Mean, Standard deviation etc. or a simple frequency of the values entered or pasted. The data values can be sorted in 
ascending or descending order. 

The Significance Testing tab offers significance testing for Two Independent Samples, Two Categories in One 
Sample, Proportion vs. Theoretical and Two Matched Samples for Percentages and Averages (Means). Simply 
enter the appropriate values to get the z score, Significance level and Confidence level for the selected test. 

The Sample Size Calculator tab provides the Sample Size Needed for a Given Confidence Interval or the 
Confidence Interval Resulting from a Given Sample Size. Just enter the appropriate values to determine either the 
Sample size needed or the Confidence interval.  

The Calculator tab provides the convenience of quick calculations that might be helpful when using the other WinCross 
Quick Tools tabs without having to leave the Quick Tools menu. 

See the WinCross online Help topic “Quick Tools” for more detailed information about these new tools. 

 

Increased Memory Capacity 

WinCross 16 offers increased memory capacity for 64-bit operating systems that will provide greater WinCross processing 
capabilities and reduce “Out of memory” conditions. 

 

New Maximums for Record Length and Number of Variables 

The maximum for record length of variable-type data has been increased and is now limited by available memory only. 
The maximum number of variables has been increased for most variable-type data files with the exception of Microsoft 
Excel 1997-2003 (*.xls) files. SPSS and comma- or tab-delimited data files can now have up to 1,048,000 variables 
depending on the record length as long as the combination does not exceed memory limits. Microsoft Excel 2007-2013 
(*.xlsx) data files can now have a maximum of 16,384 variables.   

See the WinCross online Help topic “Maximums” for more detailed information about WinCross maximums/defaults. 

 

New Square Root Function of the CALC Statement 

The CALC statement has added a new square root function (SQRT) providing more row and column logic options.   

Example: CALC SQRT {V3 - V2} 

In banner logic: 
If the above example is the logic for banner column 4, the result in banner column 4 would be the square root of the 
vertical percent of banner column 3 minus the vertical percent of banner column 2. 

In row logic: 
If the above example is the logic for table row 4, the result in table row 4 would be the square root of the vertical percent 
of table row 3 minus the vertical percent of table row 2. 

See the WinCross online Help topic “CALC Feature” for more detailed information about this new function. 

 
  



The Analytical Group, Inc.                                                                                                                         WinCross 16 What’s New      23 

New SUB/ENDSUB Feature 

A new option has been added for the SUB feature. You can now use ENDSUB to delimit the group of rows that you are 
adding using SUB logic. 

Example: 

SUB 
Row 1 
Row 2 
Row 3 
ENDSUB 

The benefit of using SUB/ENDSUB logic is that you can add or remove rows from within the logic without needing to 
change the SUB logic row. 

See the WinCross online Help topic “SUB Feature” for more detailed information about the new ENDSUB option. 

 
DECLARE New Variables in the Glossary 

You can now create new variables in the Glossary using the DECLARE instruction without the need to specify a 
record/column location or use the ADDLEN, ASSIGN or COMPUTE instructions. 

The new variables can be referenced in your job file or saved to your data file using the Save Data As option of 
Setup|Glossary Variables. 

Syntax: 
DECLARE new variable 
DECLARE new variable,new variable,new variable 
DECLARE new variable = variable 
DECLARE new variable = value 
DECLARE new variable = variable (or record/column) operator variable (or record/column) 
DECLARE new variable = variable (or record/column operator value 
 
DECLARE new variable:n (where n specifies the width of the new variable; with a maximum width of 12) can be specified 
for all of the above syntax options.  
 
If no width is specified, the default width is 12. 
 
Example 1: 
DECLARE NEW_VAR1 

Example 2: 
DECLARE NEW_VAR1,NEW_VAR2,NEW_VAR3,NEW_VAR4 

Example 3: 
DECLARE NEW_VAR1 = Q2A 

Example 4: 
DECLARE MAX_RECS = 10000 

Example 5: 
DECLARE Q2_TOT = Q2A + Q2B 

Example 6: 
DECLARE INCOME:10 = INCOME_1 * 10 

See the WinCross online Help topics “DECLARE” or “DECLARE Examples” for more detailed information about this new 
instruction and more examples of how to use it. 
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Implicit ASSIGN Instruction 

Setup|Glossary Variables now supports the implicit ASSIGN instruction. The ASSIGN keyword is only required if it is 
preceded by IF logic.  

The ASSIGN keyword is now optional for the following syntaxes: 
 
Example 1: 
ASSIGN GENDER = (1) 
or 
GENDER = (1) 

Both statements mean to assign the value of 1 into the variable GENDER. 

Example 2: 
ASSIGN Q1 = Q8 
or 

Q1 = Q8 

Both statements mean to assign the contents of variable Q8 into variable Q1. 

See the WinCross online Help topics “ASSIGN” or “ASSIGN Examples” for more detailed information about this new 
implicit instruction. 
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Multiple Job Logos and Logo Placement Options 

Your Enhanced Text Reports can now be more personalized than ever with the addition of a 2
nd

 job logo and additional 
job logo placements options.   

 

The Enhanced Text Report tab of Setup|Job Settings/Profile Settings now offers 2 job logos and each job logo has 
additional placement options. 

See the WinCross online Help topics “Job Settings|Enhanced Text Reports” or “Profile Settings|Enhanced Text Reports” 
for more detailed information about the new job logos and placement options. 
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Report Viewing Format Changes 

The Report viewing formats options of Run|Tables now allows you to create Excel reports without creating Plain text 
or Enhanced text reports too.  

 

You can select Excel by itself or with any combination of Plain text and/or Enhanced text. When Excel is selected as 
one of the Report viewing formats, Excel is now automatically launched and opens the Excel file specified on the Excel 
Options dialog. If more than one workbook is being created, the first workbook created will be opened. 

See the WinCross online Help topics “Run|Tables” and “Excel Options” for more detailed information about the changes 
to Report viewing formats. 
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Excel Options Organized in Tab View  

Excel Report Options are now presented in a more organized tab view. Each tab contains a set of options organized by 
type. 

 

You can choose between Data Options, Formatting Options, Worksheet Options, Report Options and Decimal 
Place Options. 

See the WinCross online Help topic “Excel Options” for more information about each tab of Excel Report Options. 
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New Table of Contents Options for Excel  

Run|Tables|Excel Options now has added flexibility for the Include table of contents option and including the table of 
contents becomes the new WinCross default. 

 

You can now include the table of contents in the same worksheet as the tables for the Worksheet options of Create all 
tables in one worksheet, one banner per workbook or Create one banner per worksheet, all in one workbook by 
using the new In the same worksheet as tables option.  

You can now write the table of contents to one worksheet in the same workbook when choosing the Create one banner 
per worksheet, all in one workbook or the Create each table as a separate worksheet, all in one workbook option 
by using the new In one worksheet for multiple banners option. This option is only useful if you are processing more 
than one banner and want the table of contents for each banner in one worksheet instead of three separate worksheets. 

Worksheet names will now reflect the table name when using the Create each table as a separate worksheet, one 
banner per workbook or Create each table as a separate worksheet, all in one workbook option even when you are 
not showing the table name on the Excel report. Previously the Show table name at top of page option on the Table 
Presentation tab of Job Settings had to be selected for worksheet names to reflect the table name.  

The Include table of contents option is now enabled as the WinCross default and has been relocated to the Data 
Options tab. If you do not want a table of contents created, this option will need to be disabled. 

See the WinCross online Help topic “Excel Options” for more detailed information about these new options for Excel 
reports. 
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Banner Column Width for Excel Reports 

The banner column width specified for Enhanced Text Reports on the Setup|Banners dialog is now respected when 
creating Excel reports.  

 

Each column, including Row Text is assigned a Width (in pixels). This width can be changed on the Setup Banners 
dialog and is now used for Excel reports whether they are created from Run|Tables|Excel Options or from 
File|Save|Save Report As (*.xlsx). 

See the WinCross online Help topic “Banners” for more detailed information about the Enhanced text reports: banner 
preview options. 
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New Show Job File Definition View Check Box 

The Express Tables from Variable Data dialog has a new default for displaying the Job file definition window. The Job 
file definition window will only display if you enable the new Show job file definition view check box.  

 

This new default allows the user to display more tables and to hide the Job file definition window if job file editing will 
not be done using this dialog. 

 

The Job file definition window can be easily displayed by enabling the Show job file definition view check box. This 
setting will remain selected across WinCross sessions until it is disabled by the user. 

See the WinCross online Help topic “Express Tables from Variable Data” for more detailed information about this new 
default and check box. 
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Table Filter for Express Tables from Variable Data 

You can modify filter title, logic and type using the new Filter option of Setup|Express Tables from Variable Data.  

  

You can modify a group of tables and use square brackets [ ] around elements in the logic to auto-increment. You can 
auto-increment a variable name, a numeric or single alphabetic letter portion of a variable name and code values that are 
numeric or a single alphabetic letter. 

This new option now allows you to make changes to the default filter added when you generate tables using Express 
Tables from Variable Data. 

See the WinCross online Help topic “Table Filter (Express Tables from Variable Data)” for more detailed information 
about using this new option. 
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Reverse Scale 

You can now reverse the code value scale when creating a Summary of Means table from multiple variables using the 
new Reverse scale option of Express Tables from Variable Data. 

 

This new option will automatically add the necessary logic for reversing the Code Values (for example, ^Q2A (1-5) 
#1=5,2=4,3=3,4=2,5=1)^SM). In this example, for purposes of computing the mean, the code value 1 becomes a 5, the 
code value 2 becomes a 4, the code value 3 stays a 3, the code value 4 becomes a 2 and the code value 5 becomes a 1. 

See the WinCross online Help topic “Express Tables from Variable Data” for more detailed information about using this 
new option. 

 

Use Variable Label from First Selected Variable as Table Title 

You can now use the variable label from the first selected variable as the table title when creating a Summary of Means 
or Summary of Frequencies table from multiple variables using Express Tables from Variable Data. 

 

WinCross will use a default table title if the Use variable label from first selected variable as table title option is not 
selected. 

See the WinCross online Help topic “Express Tables from Variable Data” for more detailed information about using this 
new option. 
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Net Using Code Values 

The Table Editor tab of Express Tables from Variable Data has a new option for creating net rows. 

 

The Net Using Code Values option allows you to quickly create a new row using the code values of the selected rows. 

 

See the WinCross online Help topic “Express Table Editor|Table Editor tab” for more detailed information about using this 
new option. 
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Word Wrap and Implicit Spell-checking for Row Text in the Express Table Editor 

The Express Table Editor dialog of Setup|Express Tables from Variable Data has added a Word wrap option and 
implicit spell-checking for Row Text. 

 

See the WinCross online Help topic “Express Table Editor|Table Editor tab” for more detailed information about using the 
new Word wrap option and implicit spell-checking for row text. 
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Apply Table Options to Other Tables in the Express Table Editor 

The Apply to Other Tables tab of the Express Table Editor for Setup|Express Tables from Variable Data has a new 
Also apply the table options to the selected tables option. 

 

This new option will use the table options from the selected table when creating USE tables. The table options applied 
from the selected table include any option specified on the 2

nd
 line of the table when viewing the job file using View|Job 

File (for example, OW,OV,OR,OB,P1,SM,SV,SR,SA,SP,S2,V2). 

See the WinCross online Help topic “Express Table Editor|Apply to Other Tables tab” for more detailed information about 
using this new option. 
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Get True Nets Using Indexed Variables 

WinCross 16 offers several new netting options that allow you to get a true net when using Indexed Variables. 

Example 1: 

IDXNET 3 

This logic produces a row showing the net of the next three rows below. 

Example 2: 

IDXNET 
Row 1 
Row 2 
Row 3 
ENDNET 

This logic includes the rows between the IDXNET and the ENDNET. The advantage of using IDXNET/ENDNET is that 
you can add or remove rows from within the logic without the need to change the IDXNET logic row. 

Example 3: 

IDXNET-3 

This logic produces a row showing the net of the three previous rows.  

See the WinCross online Help topic “NET/IDXNET Feature” for more detailed information about using these new options. 
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New Filter Type of Net Total (Indexed) for Tables Using Indexed Variables 

You can now get a filter row for respondents (not responses) on a table defined using Indexed Variables with the new 
Filter type of Net Total (Indexed). 

 

See the WinCross online Help topic “Table Filter” for more detailed information about using this new filter type. 
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Assign Rows to Groups 

You can now group rows together under programmed nets when ranking is assigned using the new Assign rows to 
groups option of Row Options. 

 

This new option allows for greater control over row placement by grouping rows together when ranking is being used. 

See the WinCross online Help topic “Assign rows to groups” for more detailed information about using this new row 
option. 
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Apply Across NETs and SUBs 

The Threshold option of Row Options has a new addition that will allow you to include rows defined using NET, IDXNET 
and SUB.  

 

The Apply across NETs and SUBs option has been added to allow these rows to be included in threshold determination. 

See the WinCross online Help topic “Threshold” for more information about this new option. 
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Mean Number of Mentions  

Due to popular demand, you can now show the Mean number of mentions for both rows and tables. 

 

The row Statistics option of Mean number of mentions reports the total number of responses divided by the total 
number of respondents for the row. 

 

The Table Statistics option of Mean number of mentions creates a row on your table showing the total number of 
responses divided by the total number of respondents. 

See the WinCross online Help topics “Row Options” or “Table Statistics” for more information about these new row and 
table statistics options. 
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New Frequency Report Type Options 

Frequency reports can now be presented for statistics only or with statistics in addition to the standard frequency report.  

 
 
The Statistical report option of Report type produces a summary report of statistics selected. 

 

The frequency statistics selected on the Frequency Statistics dialog will display on the Statistical report portion of the 
Frequency Report when either the Statistical report or Frequency and statistical reports options are chosen.  



The Analytical Group, Inc.                                                                                                                         WinCross 16 What’s New      42 

 

 

See the WinCross online Help topic “Run|Frequency” for more information about these new report type options. 

           

New Frequency Chart Type Options 

Frequency reports can now be presented as a selected Chart type.  
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The default chart type is Horizontal Bar, but you have the option to choose from the dropdown list of Chart types 
including None. Chart type can only be selected when the Report type of either Frequency report or Frequency and 
statistical reports is selected.  

 

See the WinCross online Help topic “Run|Frequency” for more information about this new Chart type option. 

 
Additional Frequency Statistics Options 

The Statistics option of Run|Frequency allows you to report additional statistics including the 1
st

 Quartile, 3
rd

 Quartile 
and the option to specify Values to exclude from statistics. 

 

See the WinCross online Help topics “Run|Frequency” and “Statistics glossary” for more information about running 
frequencies and the new statistics options.    
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Double-click a Single Variable for a Quick Frequency Report 

You can now double-click a single variable from the list of variables on the Run Frequency dialog to create a quick 
frequency report. 

 

See the WinCross online Help topic “Run|Frequency” for more information about frequency options. 
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Double-click a Single Table for a Quick Report 

You can now double-click a single table from the list of tables on the Run Tables dialog to create a quick report. 

 

If a banner is selected for that table, it will process the table against that banner. If the table is selected for multiple 
banners, it will process the table against all of the selected banners. If no banner is selected, the table will be processed 
with a total column. 

See the WinCross online Help topic “Run|Tables” for more information about options for running tables. 
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Ignore Ranking 

Run|Tables now lets you process tables that are ranked without the ranking applied using the new Ignore ranking 
option. This can be especially useful helpful when checking tables. You can process the tables unranked without having to 
change the option for all tables.  

 

The Ignore ranking option is not retained. Once tables have been processed, this setting is no longer selected. 

Show table of contents is the new default for the Run Tables dialog. This option will create a table of contents page 
when tables are processed. 

See the WinCross online Help topic “Run|Tables” for more information about these options. 

  



The Analytical Group, Inc.                                                                                                                         WinCross 16 What’s New      47 

New Sample Balancing Options 

Sample Balancing now offers an alternative technique for avoiding negative weights and allows you to specify the 
Goodness of fit and Maximum passes for the preferred Goodness-of-fit technique. 

 

The new Use iterative proportional fitting technique computes the sample balancing using the iterative proportional 
fitting technique and will never result in negative weights; however, this technique has a poorer Criterion of Goodness of 
Fit. 

Goodness of fit and Maximum passes can now be specified for the Use goodness-of-fit minimization technique. 

See the WinCross online Help topics “Sample Balancing: Variable data” or “Sample Balancing: ASCII data” for more 
information about these new Sample Balancing options. 
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New Factor Analysis Report Properties Option 

Factor Analysis has added a new Component score coefficient matrix option to its Report Properties list of reporting 
options. 

 

See the WinCross online Help topics “Factor Analysis: Variable data” or “Factor Analysis: ASCII data” for more 
information about Factor Analysis reporting options. 
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Create Secondary Factor Groups in Factor Analysis 

Factor Analysis will now assign respondents to a secondary factor group when applicable if the Create secondary factor 
groups option is selected. 

 
 
WinCross uses the highest factor score to determine which factor group is the best fit. In some instances, the highest 
factor score and the second highest factor score can be very similar. WinCross will determine if the respondent should 
also be assigned to a secondary factor group. 

See the WinCross online Help topics “Factor Analysis: ASCII data” or “Factor Analysis: Variable data” for more 
information about this new option. 
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Enhanced Text Reports for Sample Balancing and Factor Analysis 

Sample Balancing and Factor Analysis reports are now produced as colorful Enhanced Text Reports. 

 

These new Enhanced Text Reports can also now be saved in XML, PDF and PowerPoint formats. 

 

See the WinCross online Help topics “About Sample Balancing” or “About Factor Analysis” for more information about 
Sample Balancing and Factor Analysis. 
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Use Variables Defined or Declared in the Glossary for Running Frequencies, Simple 
Weighting, Sample Balancing or Factor Analysis 

Variables defined in the Glossary with simple logic (for example, DEFINE NEW_VAR = 1/75) or variables created using 
the new DECLARE instruction (for example, DECLARE Q6_TOT = Q6A_1 A7) are included in the Variable List if the 
Use glossary transformations option is enabled. 

 
 
This allows you to use these new variables in Frequencies, Simple Weighting, Sample Balancing or Factor Analysis. 
 

 
 
See the WinCross online Help topics “Run|Frequency”, “Simple Weighting: Variable Data”, “Sample Balancing: Variable 
Data”, “Factor Analysis: Variable Data”, “DECLARE” or “DEFINE” for more information about using variables defined in 
the Glossary. 
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View Data File Information from Setup Glossary Variables 

You can now review the variables in your data file when writing Glossary statements without having to exit the Setup 
Glossary Variables dialog. 

 

Use the new View Data File Information option to display the list of variables, including the Variable Sequence 
Number, Internal WinCross Location, Abbreviated Variable Name, Variable Name from Data File and the Variable 
Label from Data File for help in writing Glossary statements. 
 
See the WinCross online Help topic “Glossary Variables” for more information about this new helpful option. 
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Save Variable-Type Data Files to Other Formats 

File|Save|Save Data As now lets you save all variable-type data files to a new format. 

 

All variable-type data files can now be saved as SPSS (*.sav), ASCII CSV delimited (*.csv), ASCII tab delimited (*.tsv, 
*.tab), MS Excel 97-2003 (*.xls), MS Excel 2007-10 (*.xlsx), MS Excel 2007-10 (Macro enabled) (*.xlsm) or ASCII fixed 
(*)(*) format. When the data file is saved as a new format, the new file is saved and then opened in WinCross. 

See the WinCross online Help topic “Save Data As” for more information about saving data. 

 

Median Statistic Option Added for Banner Columns 

Median has been added to the list of Statistics available on the Options tab of the Banner Editor. 
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You can define a banner column using the Median statistic to report the middle value of all values specified. 

When tables are converted to banners using Create Banners from Tables, Median rows will now become Median 
banner columns. The Median row will only convert to a Median banner column if it is defined as a Median using Row 
Options. 

See the WinCross online Help topics “Options tab (Edit Banner)”, “Create Banners from Tables” and “Row Options” for 
more information about using this new banner statistic. 

 

Enhanced Text Banner Preview 

The Preview Banner option of the Banner Editor has added a new tab that lets you preview your banner in Enhanced 
Text view. 

 

This Enhanced Text preview of the banner displays how your banner will look when using the Report viewing format of 
Enhanced text report on the Run Tables dialog. 

Choose the Plain Text tab to preview the banner as it looks when using the Report viewing format of Plain text report. 

See the WinCross online Help topic “Preview Banner (Edit Banner)” for more information about previewing a banner. 
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Misspelling Alerts 

Many dialogs in the WinCross interface will now alert you to possible misspellings in table titles, filter titles, subtitles, 
footnotes, etc. 

 

 
A possible misspelling is underlined with a red squiggly line as the alert. 

If you do not want to be alerted to possible misspellings, there is a new option in Tools|Program Options to allow you to 
disable this new spelling checking feature. 

See the WinCross online Help topic “Tools|Program Options” for more information about this new program option. 

 
New Character Maximum for Table Title, Subtitle and Footnote 

The maximum number of characters for Table title, Subtitle and Footnote has been increased to 1000 characters. 

 
 
When table titles, subtitles and footnotes are entered using the WinCross interface, a counter is maintained indicating how 
many characters have been entered. 

See the WinCross online Help topics “Table title”, “Subtitle” or “Footnote” for more information about entering table titles, 
subtitles and footnotes. 
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New symbols for Incrementing/Excluding Logic for VAR+/LOC+ Banners and Tables 

For VAR+/LOC+ banners, table row and filter logic can be incremented by enclosing logic inside the following characters 
[+]…..[+]. 

Example 1: 

[+]Q2A (1) AND Q3A (1)[+] 

would increment both Q2A and Q3A 
 
Example 2: 

[+]Q2A (1)[+] AND Q3A (1) 

would increment only Q2A 
 
For VAR+/LOC+ banners, table row and filter logic can be excluded from being incremented by enclosing logic inside the 
following characters [X]…..[X]. 
 
Example 1: 

[+]Q2A (1) OR Q3A (1) OR [X]Q4A (1)[X] OR Q5A (1)[+] 

would increment Q2A, Q3A and Q5A and exclude Q4A from being incremented 
 

For VAR+/LOC+ tables, banner column logic can be incremented by enclosing logic inside the following characters 
[+]…..[+]. 

Note: Banner filter logic is never incremented. 

Example 1: 

[+]Q2A (1) AND Q3A (1)[+] 

would increment both Q2A and Q3A 
 
Example 2: 

[+]Q2A (1)[+] AND Q3A (1) 

would increment only Q2A 
 
For VAR+/LOC+ banners, banner column logic can be excluded from being incremented by enclosing logic inside the 
following characters [X]…..[X]. 
 
Example 1: 

[+]Q2A (1) OR Q3A (1) OR [X]Q4A (1)[X] OR Q5A (1)[+] 

would increment Q2A, Q3A and Q5A and exclude Q4A from being incremented 
 
See the WinCross online Help topic “Incrementing logic for VAR+/LOC+ banners and tables” for more information about 
using these new symbols. 
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New symbols for Including Logic in Row/Column Statistics 

For table row statistics, table row logic can be included in the calculations for row statistics by enclosing the logic you want 
to include inside the following characters [S]…..[S]. 

Example 1: 

^[S]Q2A (1-99)[S] AND Q3A (1)^SM 

would only include Q2A (1-99) in the calculation for row mean 
 
Example 2: 

^GENDER (1) AND Q22A (1) AND [S]Q33A (1-10)[S]^SM 

would only include Q33A (1-10) in the calculation for row mean 
 
 
For banner column statistics, banner column logic can be included by enclosing the logic you want to include inside the 
following characters [S]…..[S]. 

Example 1: 

^[S]Q2A (1-99)[S] AND Q3A (1)^SM 

would only include Q2A (1-99) in the calculation for column mean 
 
Example 2: 

^GENDER (1) AND Q22A (1) AND [S]Q33A (1-10)[S]^SM 

would only include Q33A (1-10) in the calculation for column mean 
 
See the WinCross online Help topic “Including logic for row/column statistics” for more information about using these new 
symbols. 

 
New symbols for Including Logic in Volumetric Rows 

For volumetric table rows, table row logic can be included in volumetric calculations by enclosing the logic you want to 
include inside the following characters [V]…..[V]. 

Example 1: 

^[V]Q6_1 (0-99)[V] AND Q7_1 (1)^VO 

would only include Q6_1 (0-99) in the volumetric calculation for the row 
 
Example 2: 

^[V]Q6A (1-10) AND Q7A (1-10)[V]^VO 

would include both Q6A (1-10) and Q7A (1-10) in the volumetric calculation for the row 
 
Example 3: 

^GENDER (1) AND Q5_1 (1) AND [V]Q33A (1-10)[V]^VO 

would only include Q33A (1-10) in the volumetric calculation for the row 
 
See the WinCross online Help topic “Including logic for volumetric rows” for more information about using these new 
symbols. 
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Enter Glossary Statements Without Regard to Case 

Glossary statements can now be entered in lowercase.  

 

WinCross will convert the lowercase statements to uppercase upon exit from the Setup Glossary Variables dialog. 

 
 
For purposes of using the Run TEST Commands and Check Syntax options, the Glossary statements will be 
interpreted as uppercase. You will not see the uppercase conversion until you exit the Setup Glossary Variables dialog 
and reenter the dialog or use View|Job File. 

See the WinCross online Help topic “Glossary Variables” for more information about using Glossary statements. 
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Data Transformations Applied Report Status 

WinCross now provides a status for reports indicating whether the banners processed were weighted and if glossary 
transformations were applied.  

 
 
For the Tables report, you can click on the Data transformations applied status to open the Report Log where banner 
and Glossary information is provided. 
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Other reports, such as the Frequency, Sample Balancing and Factor Analysis reports, provide the information in the 
status bar of the report dialog. 

 

See the WinCross online Help topic “Run|Tables” for more information about viewing this new Report Log information. 

 

Compatibility with Latest Version of SPSS 

WinCross 16 is compatible with SPSS version 23. For compatibility with WinCross, we recommend saving files in SPSS 
using Locale (code page) encoding. 

 
 
 
 
 
 
 
 
 
 
 


